
Q .1Q .1 In whic h r iver  was  the open water  s wimming and tr iathlon events  In whic h r iver  was  the open water  s wimming and tr iathlon events  held  dur ing theheld  dur ing the
2 0 24  Par is  O ly mpic s?2 0 24  Par is  O ly mpic s?

A nsA ns 1. Loire
2. Seine
3. Rhone
4. Garonne

Q .2Q .2 Who launc hed the Non- Ferrous  M etal  Rec y c l ing Webs ite and S takeholders’ PortalWho launc hed the Non- Ferrous  M etal  Rec y c l ing Webs ite and S takeholders’ Portal
on 7  M ay  2 0 2 5,  as  part  of  Ind ia's  efforts  toward a s us tainable c irc ular  ec onomy ?on 7  M ay  2 0 2 5,  as  part  of  Ind ia's  efforts  toward a s us tainable c irc ular  ec onomy ?

A nsA ns 1. Minister of Environment, Forest and Climate Change
2. Minister of Steel
3. Minister of Coal and Mines
4. Minister of Heavy Industries

Q .3Q .3 Who init iated the c ons truc t ion of the Q uwwat- ul- Is lam mos que,  the firs t  mos queWho init iated the c ons truc t ion of the Q uwwat- ul- Is lam mos que,  the firs t  mos que
bui lt  in Delhi  after  the Is lamic  c onques t  of  Ind ia?bui lt  in Delhi  after  the Is lamic  c onques t  of  Ind ia?

A nsA ns 1. Iltutmish
2. Alauddin Khilji
3. Qutb-ud-din Aibak
4. Muhammad Ghori

Q .4Q .4 Whic h of the fo l lowing was  the venue for  the C onference of Party  2 8 (CO P 2 8) ?Whic h of the fo l lowing was  the venue for  the C onference of Party  2 8 (CO P 2 8) ?
A nsA ns 1. 

2. 
3. 
4. 
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Q . 5Q . 5 Whic h of the fo l lowing s tates  rec orded the larges t  dec l ine in the number ofWhic h of the fo l lowing s tates  rec orded the larges t  dec l ine in the number of
M ult i - D imens ional  Poverty  Index ( M PI)  poor  between 2 0 1 3 - 1 4  and 2 0 2 2 -2 3?M ult i - D imens ional  Poverty  Index ( M PI)  poor  between 2 0 1 3 - 1 4  and 2 0 2 2 -2 3?

A nsA ns 1. Maharashtra, Tamil Nadu and Gujarat
2. West Bengal, Odisha and Assam
3. Rajasthan, Punjab and Haryana
4. Uttar Pradesh, Bihar and Madhya Pradesh

Q .6Q .6 In reference to  ty pes  of fores ts  in Ind ia ,  E bony ,  M ahogany  and Ros ewood treesIn reference to  ty pes  of fores ts  in Ind ia ,  E bony ,  M ahogany  and Ros ewood trees
are found in _________ .are found in _________ .

A nsA ns 1. tropical evergreen forests
2. thorn forests
3. mangrove forests
4. montane forests

Q .7Q .7 In July  2 0 24 ,  who was  appointed as  the Head C oac h of the Indian men's  c r ic ketIn July  2 0 24 ,  who was  appointed as  the Head C oac h of the Indian men's  c r ic ket
team?team?

A nsA ns 1. M S Dhoni

2. Virat Kohli
3. Gautam Gambhir
4. Rahul Dravid

Q .8Q .8 The eleventh fundamental  duty  was  added to  the Indian C ons t itut ion in whic h ofThe eleventh fundamental  duty  was  added to  the Indian C ons t itut ion in whic h of
the fo l lowing y ears?the fo l lowing y ears?

A nsA ns 1. 2002
2. 2003
3. 2000
4. 2001
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Q .9Q .9 Whic h of the fo l lowing fundamental  r ights  is  v io lated in the c as e below?Whic h of the fo l lowing fundamental  r ights  is  v io lated in the c as e below?
S ome poor  people in a  v i l lage were not  a l lowed to  us e the front road of theirS ome poor  people in a  v i l lage were not  a l lowed to  us e the front road of their
hous e.hous e.

A nsA ns 1. Cultural and educational rights
2. Right to constitutional remedies
3. Right to equality
4. Right to freedom of religion

Q .1 0Q .1 0 In 2 0 2 5,  Pr ime M inis ter  Narendra M odi  announced the formation of whic h of theIn 2 0 2 5,  Pr ime M inis ter  Narendra M odi  announced the formation of whic h of the
fo l lowing bodies ,  a imed at  reduc ing the ro le of  the s tate in governance andfol lowing bodies ,  a imed at  reduc ing the ro le of  the s tate in governance and
promoting ec onomic  l iberal is at ion?promoting ec onomic  l iberal is at ion?

A nsA ns 1. National Economic Advisory Council
2. Administrative Reforms Task Force
3. Deregulation Commission
4. Commission for Ease of Doing Business

Q .1 1Q .1 1 Whic h of the fo l lowing A rt ic les  of  the Indian C ons t itut ion al lows  the S upremeWhic h of the fo l lowing A rt ic les  of  the Indian C ons t itut ion al lows  the S upreme
C ourt  to  trans fer  c as es  from one High C ourt  to  another?C ourt  to  trans fer  c as es  from one High C ourt  to  another?

A nsA ns 1. Article 142
2. Article 145
3. Article 139A
4. Article 140

Q .1 2Q .1 2 Whic h of the fo l lowing s oc ia l  reformers  founded the 'The Hindu Family  A nnuityWhic h of the fo l lowing s oc ia l  reformers  founded the 'The Hindu Family  A nnuity
Fund '?Fund '?

A nsA ns 1. Raja Ram Mohan Roy
2. Keshab Chandra Sen
3. Gopal Ganesh Agarkar
4. Ishwar Chandra Vidyasagar

Q .1 3Q .1 3 Who among the fo l lowing defeated Yaldauz in 1 2 1 5 A D in the batt le of  Tarain?Who among the fo l lowing defeated Yaldauz in 1 2 1 5 A D in the batt le of  Tarain?
A nsA ns 1. Shamsuddin Iltutmish

2. Nasiruddin Mahamud
3. Bahram Shah
4. Ruknuddin
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Q .1 4Q .1 4 In whic h of the fo l lowing s tates  of Ind ia  is  Khangc hendzonga National  ParkIn whic h of the fo l lowing s tates  of Ind ia  is  Khangc hendzonga National  Park
loc ated?loc ated?

A nsA ns 1. Sikkim
2. Himachal Pradesh
3. Kerala
4. Uttar Pradesh

Q .1 5Q .1 5 A cc ording to  Indian M inerals  Yearbook  2 0 2 2 ,  whic h of the fo l lowing s tate wasA cc ording to  Indian M inerals  Yearbook  2 0 2 2 ,  whic h of the fo l lowing s tate was
the only  S tate report ing produc tion of lead c oncentrate and z inc  c oncentratethe only  S tate report ing produc tion of lead c oncentrate and z inc  c oncentrate
dur ing 2 0 2 1 -2 2 ?dur ing 2 0 2 1 -2 2 ?

A nsA ns 1. Kerala
2. Madhya Pradesh
3. Rajasthan
4. Jharkhand

Q .1 6Q .1 6 In whic h y ear  was  the firs t  c omplete cens us  c onduc ted in Ind ia?In whic h y ear  was  the firs t  c omplete cens us  c onduc ted in Ind ia?
A nsA ns 1. 1987

2. 1885
3. 1883
4. 1881

Q .1 7Q .1 7 Who among the fo l lowing is  c ons idered as  the head of the G overnment in aWho among the fo l lowing is  c ons idered as  the head of the G overnment in a
Par l iamentary  form of G overnment?Par l iamentary  form of G overnment?

A nsA ns 1. Chief Minister
2. Speaker of the House
3. President
4. Prime Minister

Q .1 8Q .1 8 When was  the ‘Brahmo S amaj ’ founded?When was  the ‘Brahmo S amaj ’ founded?
A nsA ns 1. 1890

2. 1828
3. 1830
4. 1928
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Q .1 9Q .1 9 In whic h S tate of Ind ia  is  the M arram Nagas  tr ibe mainly  found?In whic h S tate of Ind ia  is  the M arram Nagas  tr ibe mainly  found?
A nsA ns 1. Manipur

2. Nagaland
3. Haryana
4. Rajathan

Q .2 0Q .2 0 Whic h of the fo l lowing s tatements  are c orrec t  with res pec t  to  the his tory  ofWhic h of the fo l lowing s tatements  are c orrec t  with res pec t  to  the his tory  of
India?India?

( 1 )  The Br it is h fought four  wars  with the rulers  of  M y s ore in Ind ia .( 1 )  The Br it is h fought four  wars  with the rulers  of  M y s ore in Ind ia .
( 2 )  The E as t  Ind ia  C ompany  jo ined the ruler  of  Hy derabad agains t  Hy der  A l i  in( 2 )  The E as t  Ind ia  C ompany  jo ined the ruler  of  Hy derabad agains t  Hy der  A l i  in
return for  the ces s ion of the Northern S arkars  in 1 899 .  return for  the ces s ion of the Northern S arkars  in 1 899 .  
( 3 )  T ipu S ultan was  k i l led  in the Batt le of  S er ingapatam defending his  c apital( 3 )  T ipu S ultan was  k i l led  in the Batt le of  S er ingapatam defending his  c apital
S er ingapatam.S er ingapatam.

A nsA ns 1. Only 1 and 3
2. 1, 2 and 3
3. Only 2 and 3
4. Only 1 and 2

Q .2 1Q .2 1 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .
( A l l  numbers  are s ingle- d igit  numbers  only . )( A l l  numbers  are s ingle- d igit  numbers  only . )
( L eft)  8  2  1  5 7  9  8  5 2  6  2  1  5 7  3  7  8  4  3  6  9  7  4  5 2  4  1  ( Right)( L eft)  8  2  1  5 7  9  8  5 2  6  2  1  5 7  3  7  8  4  3  6  9  7  4  5 2  4  1  ( Right)
How many  s uc h odd d igits  are there,  eac h of whic h is  immediately  preceded by  anHow many  s uc h odd d igits  are there,  eac h of whic h is  immediately  preceded by  an
even d igit  and als o  immediately  fo l lowed by  an even d igit?even d igit  and als o  immediately  fo l lowed by  an even d igit?
(C ounting to  be done from left  to  r ight  only . )(C ounting to  be done from left  to  r ight  only . )

A nsA ns 1. Two
2. Four
3. One
4. Three

Section : Logical Reasoning
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Q .2 2Q .2 2 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are theS elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the
numbers  of the fo l lowing s ets .numbers  of the fo l lowing s ets .

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.  Break ing down 1 3as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )a l lowed . )

( 1 8 ,  7,  3 9)( 1 8 ,  7,  3 9)
( 1 6 ,  9 ,  43 )( 1 6 ,  9 ,  43 )

A nsA ns 1. (3, 31, 96)
2. (6, 21, 63)
3. (9, 15, 57)
4. (10, 17, 62)

Q .2 3Q .2 3 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion.Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion.

( L eft)  6  8  2  7  3  6  4  9  2  8  7  3  6  4  2  9  8  7  3  4  6  2  9  8  3  7  4  2  ( Right)( L eft)  6  8  2  7  3  6  4  9  2  8  7  3  6  4  2  9  8  7  3  4  6  2  9  8  3  7  4  2  ( Right)

How many  odd d igits  are there that  are NO T immediately  preceded by  an evenHow many  odd d igits  are there that  are NO T immediately  preceded by  an even
digit?d igit?

A nsA ns 1. Two
2. Three
3. Four
4. One
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Q .24Q .24 C  is  the brother  of B.  W is  the daughter  of P.  K  is  the daughter  of B.  N is  theC  is  the brother  of B.  W is  the daughter  of P.  K  is  the daughter  of B.  N is  the
hus band of P.  W is  the wife of B.  How is  N related to  K?hus band of P.  W is  the wife of B.  How is  N related to  K?

A nsA ns 1. Father’s mother
2. Mother’s father 
3. Father’s father
4. Brother’s wife

Q .2 5Q .2 5 A  paper  is  fo lded and c ut  as  s hown below.  How wi l l  i t  appear  when unfolded?A  paper  is  fo lded and c ut  as  s hown below.  How wi l l  i t  appear  when unfolded?

A nsA ns 1. 

2. 

3. 

4. 
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Q .2 6Q .2 6 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’
and ‘÷ ’ are interc hanged and ‘−’ and ‘× ’ are interc hanged?and ‘÷ ’ are interc hanged and ‘−’ and ‘× ’ are interc hanged?

1 62  + 1 8  ×  6  − 1 2  ÷  80  = ?1 62  + 1 8  ×  6  − 1 2  ÷  80  = ?
A nsA ns 1. 17

2. 26
3. 24
4. 10

Q .2 7Q .2 7 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-
c lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus terc lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter
DO E S  NO T belong to  that  group?  ( Note:  The odd one out is  not  bas ed on theDO E S  NO T belong to  that  group?  ( Note:  The odd one out is  not  bas ed on the
number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. YGC
2. RYV
3. HOL
4. FMJ

Q .2 8Q .2 8 S elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairsS elec t  the pair  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two pairs
given below.  Both pairs  fo l low the s ame pattern.  given below.  Both pairs  fo l low the s ame pattern.  
BXO  :  E BRBXO  :  E BR
HV G  :  KZJHV G  :  KZJ

A nsA ns 1. DCT : JBV
2. JSA : MWD
3. ZBI :  DDK
4. LAV : OCX
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Q .2 9Q .2 9 In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certainIn the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certain
mathematic al  operat ions  to  the firs t  number.  Whic h numbers  s hould  replace Xmathematic al  operat ions  to  the firs t  number.  Whic h numbers  s hould  replace X
and Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s ide of : :  isand Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s ide of : :  is
s ame as  that  on the r ight  s ide of : : ?s ame as  that  on the r ight  s ide of : : ?

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  intoas  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into
1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )

X  :  1 4 9 : :  62  :  YX :  1 4 9 : :  62  :  Y
A nsA ns 1. X = 72, Y = 127

2. X = 74, Y = 165
3. X = 73, Y = 167
4. X = 74, Y = 125

Q .3 0Q .3 0 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l lRefer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l l
numbers  are s ingle- d igit  numbers  only . )numbers  are s ingle- d igit  numbers  only . )
( L eft)  1  3  2  5 6  8  9  2  8  4  1  3  2  5 7  9  8  4  5 2  6  8  9  3  5 ( Right)( L eft)  1  3  2  5 6  8  9  2  8  4  1  3  2  5 7  9  8  4  5 2  6  8  9  3  5 ( Right)
How many  s uc h odd d igits  are there,  eac h of whic h is  immediately  preceded by  anHow many  s uc h odd d igits  are there,  eac h of whic h is  immediately  preceded by  an
even d igit  and als o  immediately  fo l lowed by  an odd d igit?  (C ounting to  be doneeven d igit  and als o  immediately  fo l lowed by  an odd d igit?  (C ounting to  be done
from left  to  r ight  only . )from left  to  r ight  only . )

A nsA ns 1. Two
2. Four
3. One
4. Three
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Q .3 1Q .3 1 In the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent oneIn the fo l lowing tr iads ,  eac h group of letters  is  related to  the s ubs equent one
fol lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  thefo l lowing a certain logic .  S elec t  from the given options ,  the one that  fo l lows  the
s ame logic .s ame logic .

A PE S  -  E A PS  -  S E PAA PE S  -  E A PS  -  S E PA
C A L M  -  LC A M  -  M L A CC A L M  -  LC A M  -  M L A C

A nsA ns 1. GAIN - GIAN - NIAG
2. RING - IRNG - GINR
3. HURT - RHUT - TRUH
4. RAIN - IRAN - AINR

Q .3 2Q .3 2 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

-7  -7  2 1  2 1  - 63  - 63  1 89 1 89 ?  ?  1 70 11 70 1
A nsA ns 1. -559

2. -561
3. -567
4. -556

Q .3 3Q .3 3 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus terBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ter
pairs  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter  pairpairs  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter  pair
DO E S  NO T belong to  that  group?DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their
pos it ion in the letter- c lus ter. )pos it ion in the letter- c lus ter. )

A nsA ns 1. JM - NQ
2. DG - IL
3. BE - FI
4. PS - TW
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Q .3 4Q .3 4 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i f  ' × 'What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i f  ' × '
and '− '  are interc hanged,  and '÷ '  and '+ '  are interc hanged?and '−'  are interc hanged,  and '÷ '  and '+ '  are interc hanged?

682  + 2 2  − 5 ÷  2 5 ×  1 1  =  ?682  + 2 2  − 5 ÷  2 5 ×  1 1  =  ?
A nsA ns 1. 169

2. 187
3. 185
4. 170

Q .3 5Q .3 5 S even people,  W,  X ,  Y,  Z ,  P,  Q ,  and R,  are s itt ing in a  row,  fac ing north.S even people,  W,  X ,  Y,  Z ,  P,  Q ,  and R,  are s itt ing in a  row,  fac ing north.
ii .  .  R is  s ec ond to  the left  of  Q .R is  s ec ond to  the left  of  Q .

i ii i .  .  W and Y  s it  at  the two extreme ends .W and Y  s it  at  the two extreme ends .
i i ii i i .  .  P  s its  immediately  next  to  both Q  and Y.P  s its  immediately  next  to  both Q  and Y.
iviv .  .  Z  s its  to  the immediate r ight  of W.Z s its  to  the immediate r ight  of W.
vv .  .  X  s its  immediately  next  to  both R and Q .X  s its  immediately  next  to  both R and Q .

Who s its  to  the immediate r ight  of X?Who s its  to  the immediate r ight  of X?
A nsA ns 1. W

2. R
3. Q
4. Y

Q .3 6Q .3 6 What wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i fWhat wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i f
‘+ ’ and ‘−’ are interc hanged,  and ‘× ’ and ‘÷ ’ are interc hanged?‘+’ and ‘−’ are interc hanged,  and ‘× ’ and ‘÷ ’ are interc hanged?

3 0  ÷  2  ×  3  + 8  – 4  = ?3 0  ÷  2  ×  3  + 8  – 4  = ?
A nsA ns 1. 12

2. 14
3. 8
4. 16
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Q .3 7Q .3 7 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?  What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?  

52 2  52 2  4 88 4 88 4 54  4 54  ?  ?  3 86 3 86 3 523 52
A nsA ns 1. 

2. 
3. 
4. 

Q .3 8Q .3 8 Whic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the patternWhic h of the fo l lowing letter- c lus ters  s hould  replace # and % s o that  the pattern
and relat ions hip fo l lowed between the letter- c lus ter  pair  on the left  s ide of : :  isand relat ions hip fo l lowed between the letter- c lus ter  pair  on the left  s ide of : :  is
the s ame as  that  on the r ight  s ide of : : ?  the s ame as  that  on the r ight  s ide of : : ?  

# :  UO Z : :  BLG  :  %# :  UO Z : :  BLG  :  %
A nsA ns 1. # = TNY, % = CMI

2. # = TMY, % = DNH
3. # = SNX, % = CNH
4. # = SMX, % = DNI

Q .3 9Q .3 9 In a  race,  Raj i  is  behind Jy o ,  who is  behind A nvi .  M anu is  ahead of A nvi  but  behindIn a  race,  Raj i  is  behind Jy o ,  who is  behind A nvi .  M anu is  ahead of A nvi  but  behind
V inutha.  G our i  is  ahead of V inutha.  What c onc lus ion c an definitely  be drawn fromV inutha.  G our i  is  ahead of V inutha.  What c onc lus ion c an definitely  be drawn from
the above s tatements?the above s tatements?

A nsA ns 1. 
2. 
3. 
4. 

Q .4 0Q .4 0 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion.Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion.

( L eft)  F J  F  V  C  S  X  N I  P  C  B  S  W B  N N Z C  N P  B  D  G  S  ( Right)( L eft)  F J  F  V  C  S  X  N I  P  C  B  S  W B  N N Z C  N P  B  D  G  S  ( Right)

How many  letters  are there in the E ngl is h a lphabetic al  s er ies  between the fourthHow many  letters  are there in the E ngl is h a lphabetic al  s er ies  between the fourth
letter  from the left  and the s ixth letter  from the r ight?letter  from the left  and the s ixth letter  from the r ight?

A nsA ns 1. Two
2. Six
3. Eleven
4. Seven
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Q .4 1Q .4 1 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.

L ive hand to  mouthL ive hand to  mouth
A nsA ns 1. To have no money to provide food and shelter

2. To live king-like
3. To work hard for a living
4. To have only enough money to provide food and shelter 

Q .4 2Q .4 2 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

RememberRemember
A nsA ns 1. Forget

2. Think
3. Memorise
4. Owe

Q .43Q .43 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

Dur ing the interv iew,  the c andidateDuring the interv iew,  the c andidate ________________________ his  pas t  fa i lures  as  valuablehis  pas t  fa i lures  as  valuable
les s ons  that  s haped his  c urrent approac h to  problem- s olv ing.les s ons  that  s haped his  c urrent approac h to  problem- s olv ing.

A nsA ns 1. highlighted
2. fabricated
3. concealed
4. punished

Q .4 4Q .4 4 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given groupS elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group
of words .of  words .

A  government by  the wealthyA  government by  the wealthy
A nsA ns 1. Theocracy

2. Autocracy
3. Democracy
4. Plutocracy

Section : General English and Comprehension
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Q .4 5Q .4 5 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

M ary  ______ s wim ac ros s  the r iver  in 1 0  minutes .M ary  ______ s wim ac ros s  the r iver  in 1 0  minutes .
A nsA ns 1. were

2. be
3. had
4. can 

C omprehens ion:C omprehens ion:
Read the following passage and answer the questions that follow.

Vandana Shiva, a renowned environmentalist and social activist, opposes aspects of
globalisation that harm life and society. With a background in science and philosophy, she
critiques the Green Revolution and Genetically Modified Organisms (GMOs) for their
adverse effects on India's indigenous farming. She criticises the idea that everything is
hard matter, unrelated to each other. Her work on quantum theory emphasises
interconnectedness of all life. She believes that science is taught in a one-eyed fashion: all
about how to unleash things into the environment but not the impact. She argues that the
current scientific approaches, influenced by mechanistic thinking, overlook the impact on
ecosystems. Shiva advocates for 'seed freedom,' opposing multinational corporations'
control over seeds, which she sees as a threat to life's evolution. She calls for a new
paradigm to live harmoniously with nature, criticising globalisation as a force that
perpetuates inequality, environmental destruction, and cultural erosion, calling it a 'war
against nature, women, children, and the poor.'

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 What has  Vandana S hiva d is c us s ed in the pas s age?What has  Vandana S hiva d is c us s ed in the pas s age?
A nsA ns 1. Vandana Shiva claims that the environment is totally unrelated, and it is a hard

matter that functions in isolation.
2. Vandana Shiva voices for indigenous farming practices, bio diversity, and the rights

of the farmers.
3. Vandana Shiva advocates for Green Revolution as it increases the output.
4. Vandana Shiva recommends genetically modified organisms as they increase the

fertility of the soil.
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C omprehens ion:C omprehens ion:

Read the following passage and answer the questions that follow.

Vandana Shiva, a renowned environmentalist and social activist, opposes aspects of
globalisation that harm life and society. With a background in science and philosophy, she
critiques the Green Revolution and Genetically Modified Organisms (GMOs) for their
adverse effects on India's indigenous farming. She criticises the idea that everything is
hard matter, unrelated to each other. Her work on quantum theory emphasises
interconnectedness of all life. She believes that science is taught in a one-eyed fashion: all
about how to unleash things into the environment but not the impact. She argues that the
current scientific approaches, influenced by mechanistic thinking, overlook the impact on
ecosystems. Shiva advocates for 'seed freedom,' opposing multinational corporations'
control over seeds, which she sees as a threat to life's evolution. She calls for a new
paradigm to live harmoniously with nature, criticising globalisation as a force that
perpetuates inequality, environmental destruction, and cultural erosion, calling it a 'war
against nature, women, children, and the poor.'

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 Identify  the fac t  given in the pas s age from the options .Identify  the fac t  given in the pas s age from the options .
A nsA ns 1. Genetic engineering believes genes are related with each other.

2. Green revolution promotes indigenous farming practices.
3. Vandana Shiva is convinced that the earth is interconnected.
4. Globalisation promotes monoculture and peace in the society.
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C omprehens ion:C omprehens ion:
Read the following passage and answer the questions that follow.

Vandana Shiva, a renowned environmentalist and social activist, opposes aspects of
globalisation that harm life and society. With a background in science and philosophy, she
critiques the Green Revolution and Genetically Modified Organisms (GMOs) for their
adverse effects on India's indigenous farming. She criticises the idea that everything is
hard matter, unrelated to each other. Her work on quantum theory emphasises
interconnectedness of all life. She believes that science is taught in a one-eyed fashion: all
about how to unleash things into the environment but not the impact. She argues that the
current scientific approaches, influenced by mechanistic thinking, overlook the impact on
ecosystems. Shiva advocates for 'seed freedom,' opposing multinational corporations'
control over seeds, which she sees as a threat to life's evolution. She calls for a new
paradigm to live harmoniously with nature, criticising globalisation as a force that
perpetuates inequality, environmental destruction, and cultural erosion, calling it a 'war
against nature, women, children, and the poor.'

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 What c an be inferred from her  not ion 's eed freedom'?What c an be inferred from her  not ion 's eed freedom'?
A nsA ns 1. The seeds should be removed from the shells.

2. Farmers should have the liberty to save seeds, exchange seeds, and sow seeds
without paying.

3. Farmers should have the freedom to buy seeds from any corporate.
4. Seeds should be free from pesticides.
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C omprehens ion:C omprehens ion:

Read the following passage and answer the questions that follow.

Vandana Shiva, a renowned environmentalist and social activist, opposes aspects of
globalisation that harm life and society. With a background in science and philosophy, she
critiques the Green Revolution and Genetically Modified Organisms (GMOs) for their
adverse effects on India's indigenous farming. She criticises the idea that everything is
hard matter, unrelated to each other. Her work on quantum theory emphasises
interconnectedness of all life. She believes that science is taught in a one-eyed fashion: all
about how to unleash things into the environment but not the impact. She argues that the
current scientific approaches, influenced by mechanistic thinking, overlook the impact on
ecosystems. Shiva advocates for 'seed freedom,' opposing multinational corporations'
control over seeds, which she sees as a threat to life's evolution. She calls for a new
paradigm to live harmoniously with nature, criticising globalisation as a force that
perpetuates inequality, environmental destruction, and cultural erosion, calling it a 'war
against nature, women, children, and the poor.'

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 S elec t  the mos t appropr iate A NTO NYM  of the word ‘unleas h’ as  us ed in the givenS elec t  the mos t appropr iate A NTO NYM  of the word ‘unleas h’ as  us ed in the given

pas s age.pas s age.
A nsA ns 1. Let loose

2. Shoot
3. Release
4. Restrain
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C omprehens ion:C omprehens ion:
Read the following passage and answer the questions that follow.

Vandana Shiva, a renowned environmentalist and social activist, opposes aspects of
globalisation that harm life and society. With a background in science and philosophy, she
critiques the Green Revolution and Genetically Modified Organisms (GMOs) for their
adverse effects on India's indigenous farming. She criticises the idea that everything is
hard matter, unrelated to each other. Her work on quantum theory emphasises
interconnectedness of all life. She believes that science is taught in a one-eyed fashion: all
about how to unleash things into the environment but not the impact. She argues that the
current scientific approaches, influenced by mechanistic thinking, overlook the impact on
ecosystems. Shiva advocates for 'seed freedom,' opposing multinational corporations'
control over seeds, which she sees as a threat to life's evolution. She calls for a new
paradigm to live harmoniously with nature, criticising globalisation as a force that
perpetuates inequality, environmental destruction, and cultural erosion, calling it a 'war
against nature, women, children, and the poor.'

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 From her  phras e 'new paradigm for  l iv ing on the earth' ,  i t  c an be deduced that :From her  phras e 'new paradigm for  l iv ing on the earth' ,  i t  c an be deduced that :
A nsA ns 1. globalisation transforms every community into a war zone

2. women play a vital role in maintaining a sustainable relationship with the earth
3. it is high time to stop using chemical fertilisers as they are of no use
4. ecological agriculture is the need of the hour as it rejuvenates biodiversity

Section : General Hindi and Comprehension
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Q . 51Q . 51 WनYZल\ख तWनYZल\ख त   म`म`   सेसे   कौ नकौ न -- सासा   ग ुणवा चकगुणवा चक   Wवशेष णWवशेष ण   mा नवा चकmा नवा चक   हैहै ??
A nsA ns 1. सतही

2. नुकqला
3. भूत
4. दानी

Q . 52Q . 52 WनYZल\ख तWनYZल\ख त   Wवक uvWवक uv   म`म`   सेसे   सहीसही   Wवलो मWवलो म -- युyयुy   चुWनएचुWनए
A nsA ns 1. गु{-लघु

2. गु{-लंबा
3. गु{-मृदु
4. गु{-दीघ�

Q . 53Q . 53 ‘‘ घा वघा व   प रप र   नमकनमक   �छड़ क ना�छड़ क ना ’ ’ मुहा वरेमुहा वरे   काका   �ा�ा   अथ�अथ�   हैहै ??
A nsA ns 1. �स� करना

2. और दःुखी करना
3. Wनक�ा काम करना
4. अ�ंत ल��त होना

Q . 54Q . 54 ‘‘ घा टघा ट   घा टघा ट   काका   पा नीपा नी   पी नापी ना ’ ’ मुहा वरेमुहा वरे   काका   �ा�ा   अथ�अथ�   हैहै ??
A nsA ns 1. दःुख ताजा होना

2. बहुत �ादा पानी पीना
3. बहुत अनुभवी होना
4. �भाव होना

Q . 55Q . 55 WनYZल\ख तWनYZल\ख त   Wवक uvWवक uv   म`म`   सेसे   सहीसही   Wवलो मWवलो म -- युyयुy   चुWनए .चुWनए .
A nsA ns 1. Wनयत-नीयत

2. Wनयत-Wनयामक
3. Wनयत-WनयWमत
4. Wनयत-अWनयत
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C omprehens ion:C omprehens ion:
नीचे �दए गए प�र�ेद को �ान से पढ़̀ और पूछे गए ��v के उ�र द̀।
Zसनेमा-�च�v म̀ �ायः Zजस तरह के �� �दखाए जाते ह , उनका युवकv के च�र� पर बुरा प�रणाम देखकर योरोप के
कई देशv ने 16 वष� से कम उ¢ के कुमारv को Zसनेमा देखने का कानूनी Wनषेध कर �दया है। ह�ा और डाके के जो
क¥ड इतने सजीव §प म̀ �दखाए जाते ह . उनका िकसी के च�र� पर भी अ�ा असर नह© पड़ सकता। कुमारv के
कोमल ªदय पर तो उसका असर इतना खराब होता है िक िकतनv ही ने उसे काय� §प म̀ लाने कq चे«ा कq है और
आज जेलखानv म̀ च­q पीस रहे ह । Zश®ोपयोगी �च�v से अलब�ा युवकv का बहुत कुछ उपकार होने कq आशा कq
जाती है। भूगोल, इWतहास, आरो¯ आ�द Wवषयv कq Zश®ा �च�v °ारा बहुत ही सरल और मनोरंजक हो गई है, पर
Zश®ा-Zस±¥त के मम�²v को ये Zश®ा-Wवषयक �च�पट भी दोष से खाली नह© �दखते। इनका असर इतना ख़राब तो
नह© होता, िक कुकृ�v कq ओर ले जाय, पर बौµ±क Wवकास म̀ इससे बड़ी बाधा पड़ती है। लड़कv म̀ जो Zज²ासा-वृ¶�
होती है, उसे शा· करने का यह¸ कोई साधन नह©। वे केवल आँखv से देखते ह , बुµ± और तुलना शº» से काम लेने
का उ¼̀ कोई अवसर नह© Wमलता। इस तरह उनका मन Wवलास-ि�य हो जाता है और उसम̀ Wवचार कq शº» Zश¶थल
हो जाती है। यह¸ तक िक उनका कहना है िक बहुतेरे  युवकv कq मानZसक Zश¶थलता इतनी बढ़ गई है िक वे जो ��
देखते ह , उनकq बार½िकयv को याद नह© रख सकते। बालकv म̀ जो ि¾या¿क और नई-नई बात` खोज Wनकालने कq
�वृ¶� है, वह यह¸ WबÀुल दब जाती है। मगर Zसनेमा का �चार �दन-�दन बढ़ता जा रहा है, और अ�े िफÂ खोजने
से भी नह© Wमलते। जब तक यह Ãवसाय सुZशZ®त और Wवचारशील तथा च�र�वान Ãº»यv के हाथ म̀ न जायगा,
इसके सुधरने कq कोई आशा नह©।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 प �र �ेदप �र �ेद   काका   उ �चतउ �चत   शी ष �कशी ष�क   हो गाहो गा --
A nsA ns 1. Zसनेमा और यूरोप

2. Zसनेमा का दुÄभाव
3. Zसनेमा और समाज
4. Zसनेमा और युवक
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C omprehens ion:C omprehens ion:
नीचे �दए गए प�र�ेद को �ान से पढ़̀ और पूछे गए ��v के उ�र द̀।
Zसनेमा-�च�v म̀ �ायः Zजस तरह के �� �दखाए जाते ह , उनका युवकv के च�र� पर बुरा प�रणाम देखकर योरोप के
कई देशv ने 16 वष� से कम उ¢ के कुमारv को Zसनेमा देखने का कानूनी Wनषेध कर �दया है। ह�ा और डाके के जो
क¥ड इतने सजीव §प म̀ �दखाए जाते ह . उनका िकसी के च�र� पर भी अ�ा असर नह© पड़ सकता। कुमारv के
कोमल ªदय पर तो उसका असर इतना खराब होता है िक िकतनv ही ने उसे काय� §प म̀ लाने कq चे«ा कq है और
आज जेलखानv म̀ च­q पीस रहे ह । Zश®ोपयोगी �च�v से अलब�ा युवकv का बहुत कुछ उपकार होने कq आशा कq
जाती है। भूगोल, इWतहास, आरो¯ आ�द Wवषयv कq Zश®ा �च�v °ारा बहुत ही सरल और मनोरंजक हो गई है, पर
Zश®ा-Zस±¥त के मम�²v को ये Zश®ा-Wवषयक �च�पट भी दोष से खाली नह© �दखते। इनका असर इतना ख़राब तो
नह© होता, िक कुकृ�v कq ओर ले जाय, पर बौµ±क Wवकास म̀ इससे बड़ी बाधा पड़ती है। लड़कv म̀ जो Zज²ासा-वृ¶�
होती है, उसे शा· करने का यह¸ कोई साधन नह©। वे केवल आँखv से देखते ह , बुµ± और तुलना शº» से काम लेने
का उ¼̀ कोई अवसर नह© Wमलता। इस तरह उनका मन Wवलास-ि�य हो जाता है और उसम̀ Wवचार कq शº» Zश¶थल
हो जाती है। यह¸ तक िक उनका कहना है िक बहुतेरे  युवकv कq मानZसक Zश¶थलता इतनी बढ़ गई है िक वे जो ��
देखते ह , उनकq बार½िकयv को याद नह© रख सकते। बालकv म̀ जो ि¾या¿क और नई-नई बात` खोज Wनकालने कq
�वृ¶� है, वह यह¸ WबÀुल दब जाती है। मगर Zसनेमा का �चार �दन-�दन बढ़ता जा रहा है, और अ�े िफÂ खोजने
से भी नह© Wमलते। जब तक यह Ãवसाय सुZशZ®त और Wवचारशील तथा च�र�वान Ãº»यv के हाथ म̀ न जायगा,
इसके सुधरने कq कोई आशा नह©।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 ZसनेमाZसनेमा   समा जसमा ज   कोको   सा थ�कसा थ�क   �द शा�द शा   त भीत भी   देदे   सक तासक ता   हैहै ,  ,  जबजब --
A nsA ns 1. उसका WनमÅण यथाथ�परक हो

2. उसके WनमÅण म̀ सामाZजक-राजनीWतक छÆक भी हो
3. उसका WनमÅण राजनीWत क̀�Çत हो
4. उसका WनमÅण सचेत और शु�चतापूण� ढंग से िकया गया हो
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C omprehens ion:C omprehens ion:
नीचे �दए गए प�र�ेद को �ान से पढ़̀ और पूछे गए ��v के उ�र द̀।
Zसनेमा-�च�v म̀ �ायः Zजस तरह के �� �दखाए जाते ह , उनका युवकv के च�र� पर बुरा प�रणाम देखकर योरोप के
कई देशv ने 16 वष� से कम उ¢ के कुमारv को Zसनेमा देखने का कानूनी Wनषेध कर �दया है। ह�ा और डाके के जो
क¥ड इतने सजीव §प म̀ �दखाए जाते ह . उनका िकसी के च�र� पर भी अ�ा असर नह© पड़ सकता। कुमारv के
कोमल ªदय पर तो उसका असर इतना खराब होता है िक िकतनv ही ने उसे काय� §प म̀ लाने कq चे«ा कq है और
आज जेलखानv म̀ च­q पीस रहे ह । Zश®ोपयोगी �च�v से अलब�ा युवकv का बहुत कुछ उपकार होने कq आशा कq
जाती है। भूगोल, इWतहास, आरो¯ आ�द Wवषयv कq Zश®ा �च�v °ारा बहुत ही सरल और मनोरंजक हो गई है, पर
Zश®ा-Zस±¥त के मम�²v को ये Zश®ा-Wवषयक �च�पट भी दोष से खाली नह© �दखते। इनका असर इतना ख़राब तो
नह© होता, िक कुकृ�v कq ओर ले जाय, पर बौµ±क Wवकास म̀ इससे बड़ी बाधा पड़ती है। लड़कv म̀ जो Zज²ासा-वृ¶�
होती है, उसे शा· करने का यह¸ कोई साधन नह©। वे केवल आँखv से देखते ह , बुµ± और तुलना शº» से काम लेने
का उ¼̀ कोई अवसर नह© Wमलता। इस तरह उनका मन Wवलास-ि�य हो जाता है और उसम̀ Wवचार कq शº» Zश¶थल
हो जाती है। यह¸ तक िक उनका कहना है िक बहुतेरे  युवकv कq मानZसक Zश¶थलता इतनी बढ़ गई है िक वे जो ��
देखते ह , उनकq बार½िकयv को याद नह© रख सकते। बालकv म̀ जो ि¾या¿क और नई-नई बात` खोज Wनकालने कq
�वृ¶� है, वह यह¸ WबÀुल दब जाती है। मगर Zसनेमा का �चार �दन-�दन बढ़ता जा रहा है, और अ�े िफÂ खोजने
से भी नह© Wमलते। जब तक यह Ãवसाय सुZशZ®त और Wवचारशील तथा च�र�वान Ãº»यv के हाथ म̀ न जायगा,
इसके सुधरने कq कोई आशा नह©।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 बÉvबÉv   कोको   ZसनेमाZसनेमा   सेसे   दूरदूर   र ख नार ख ना   चा �हएचा �हए । । �v िक�v िक --
A nsA ns 1. वे �ादा भावुक होते ह 

2 . उनकq चेतना तीÊण होती है
3. उनका ªदय कोमल होता है
4. उनम̀ उ�चत-अनु�चत का Wववेक WवकZसत नह© होता है
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C omprehens ion:C omprehens ion:
नीचे �दए गए प�र�ेद को �ान से पढ़̀ और पूछे गए ��v के उ�र द̀।
Zसनेमा-�च�v म̀ �ायः Zजस तरह के �� �दखाए जाते ह , उनका युवकv के च�र� पर बुरा प�रणाम देखकर योरोप के
कई देशv ने 16 वष� से कम उ¢ के कुमारv को Zसनेमा देखने का कानूनी Wनषेध कर �दया है। ह�ा और डाके के जो
क¥ड इतने सजीव §प म̀ �दखाए जाते ह . उनका िकसी के च�र� पर भी अ�ा असर नह© पड़ सकता। कुमारv के
कोमल ªदय पर तो उसका असर इतना खराब होता है िक िकतनv ही ने उसे काय� §प म̀ लाने कq चे«ा कq है और
आज जेलखानv म̀ च­q पीस रहे ह । Zश®ोपयोगी �च�v से अलब�ा युवकv का बहुत कुछ उपकार होने कq आशा कq
जाती है। भूगोल, इWतहास, आरो¯ आ�द Wवषयv कq Zश®ा �च�v °ारा बहुत ही सरल और मनोरंजक हो गई है, पर
Zश®ा-Zस±¥त के मम�²v को ये Zश®ा-Wवषयक �च�पट भी दोष से खाली नह© �दखते। इनका असर इतना ख़राब तो
नह© होता, िक कुकृ�v कq ओर ले जाय, पर बौµ±क Wवकास म̀ इससे बड़ी बाधा पड़ती है। लड़कv म̀ जो Zज²ासा-वृ¶�
होती है, उसे शा· करने का यह¸ कोई साधन नह©। वे केवल आँखv से देखते ह , बुµ± और तुलना शº» से काम लेने
का उ¼̀ कोई अवसर नह© Wमलता। इस तरह उनका मन Wवलास-ि�य हो जाता है और उसम̀ Wवचार कq शº» Zश¶थल
हो जाती है। यह¸ तक िक उनका कहना है िक बहुतेरे  युवकv कq मानZसक Zश¶थलता इतनी बढ़ गई है िक वे जो ��
देखते ह , उनकq बार½िकयv को याद नह© रख सकते। बालकv म̀ जो ि¾या¿क और नई-नई बात` खोज Wनकालने कq
�वृ¶� है, वह यह¸ WबÀुल दब जाती है। मगर Zसनेमा का �चार �दन-�दन बढ़ता जा रहा है, और अ�े िफÂ खोजने
से भी नह© Wमलते। जब तक यह Ãवसाय सुZशZ®त और Wवचारशील तथा च�र�वान Ãº»यv के हाथ म̀ न जायगा,
इसके सुधरने कq कोई आशा नह©।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 इसइस   Ã वसा यÃ वसा य   कqकq   बेहत र½बेहत र½   केके   ZलएZलए   आ व�कआ व�क   हैहै   िकिक --
A nsA ns 1. नायक-नाºयका �Zस± हv

2. WनदËशक धनवान हो
3. Ãवसाय सुZशZ®त-च�र�वान Ãº»यv के हाथ म̀ हो
4. बÉv के Zलए अवैध हो
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C omprehens ion:C omprehens ion:
नीचे �दए गए प�र�ेद को �ान से पढ़̀ और पूछे गए ��v के उ�र द̀।
Zसनेमा-�च�v म̀ �ायः Zजस तरह के �� �दखाए जाते ह , उनका युवकv के च�र� पर बुरा प�रणाम देखकर योरोप के
कई देशv ने 16 वष� से कम उ¢ के कुमारv को Zसनेमा देखने का कानूनी Wनषेध कर �दया है। ह�ा और डाके के जो
क¥ड इतने सजीव §प म̀ �दखाए जाते ह . उनका िकसी के च�र� पर भी अ�ा असर नह© पड़ सकता। कुमारv के
कोमल ªदय पर तो उसका असर इतना खराब होता है िक िकतनv ही ने उसे काय� §प म̀ लाने कq चे«ा कq है और
आज जेलखानv म̀ च­q पीस रहे ह । Zश®ोपयोगी �च�v से अलब�ा युवकv का बहुत कुछ उपकार होने कq आशा कq
जाती है। भूगोल, इWतहास, आरो¯ आ�द Wवषयv कq Zश®ा �च�v °ारा बहुत ही सरल और मनोरंजक हो गई है, पर
Zश®ा-Zस±¥त के मम�²v को ये Zश®ा-Wवषयक �च�पट भी दोष से खाली नह© �दखते। इनका असर इतना ख़राब तो
नह© होता, िक कुकृ�v कq ओर ले जाय, पर बौµ±क Wवकास म̀ इससे बड़ी बाधा पड़ती है। लड़कv म̀ जो Zज²ासा-वृ¶�
होती है, उसे शा· करने का यह¸ कोई साधन नह©। वे केवल आँखv से देखते ह , बुµ± और तुलना शº» से काम लेने
का उ¼̀ कोई अवसर नह© Wमलता। इस तरह उनका मन Wवलास-ि�य हो जाता है और उसम̀ Wवचार कq शº» Zश¶थल
हो जाती है। यह¸ तक िक उनका कहना है िक बहुतेरे  युवकv कq मानZसक Zश¶थलता इतनी बढ़ गई है िक वे जो ��
देखते ह , उनकq बार½िकयv को याद नह© रख सकते। बालकv म̀ जो ि¾या¿क और नई-नई बात` खोज Wनकालने कq
�वृ¶� है, वह यह¸ WबÀुल दब जाती है। मगर Zसनेमा का �चार �दन-�दन बढ़ता जा रहा है, और अ�े िफÂ खोजने
से भी नह© Wमलते। जब तक यह Ãवसाय सुZशZ®त और Wवचारशील तथा च�र�वान Ãº»यv के हाथ म̀ न जायगा,
इसके सुधरने कq कोई आशा नह©।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 ZसनेमाZसनेमा   काका   समा जसमा ज   सेसे   कै साकै सा   संबंधसंबंध   हो नाहो ना   चा �हएचा �हए  ? ?
A nsA ns 1. यथाथ�परक और वायवीय

2. शु�चतापूण� और काuWनक
3. यथाथ�परक और शु�चतापूण�
4. काuWनक और वायवीय

Section : Basic Knowledge of Computer
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Q .61Q .61 Whic h of the fo l lowing s teps  is  ty pic al ly  involved in c onfiguring a web brows er  toWhic h of the fo l lowing s teps  is  ty pic al ly  involved in c onfiguring a web brows er  to
us e a  proxy  s erver?us e a  proxy  s erver?

A nsA ns 1. Open the command prompt -> Type in the proxy server address -> Press Enter
2. Install a third-party application -> Run the application -> Enter the proxy server

details
3. Open the web browser -> Navigate to the settings menu -> Select the 'Network' or

'Connection' settings -> Enter the proxy server details
4. Restart the computer -> Hold down the F8 key -> Configure the proxy server in safe

mode

Q .62Q .62
A nsA ns 1. 

2. 
3. 
4. 

Q .63Q .63 Whic h of the fo l lowing options  is  NO T pres ent under  the S tart  button -  PowerWhic h of the fo l lowing options  is  NO T pres ent under  the S tart  button -  Power
button ic on on a Windows  des ktop?button ic on on a Windows  des ktop?

A nsA ns 1. Sign-in options
2. Restart
3. Shut down
4. Sleep

Q .64Q .64 Whic h of the fo l lowing ac t ions  a l lows  y ou to  ins ert  an M S  E xcel  works heet intoWhic h of the fo l lowing ac t ions  a l lows  y ou to  ins ert  an M S  E xcel  works heet into
an M S  PowerPoint  pres entat ion?an M S  PowerPoint  pres entat ion?

A nsA ns 1. Click on 'File' and select 'Import'.
2 . Right-click on the slide and choose 'Insert Chart'.
3. Use the 'Home' tab to copy and paste the worksheet.
4. Click on the 'Insert' tab and select 'Object'.

Q .65Q .65 Whic h of the fo l lowing is  a  c ommon method that  c omputer  v irus es  us e toWhic h of the fo l lowing is  a  c ommon method that  c omputer  v irus es  us e to
propagate?propagate?

A nsA ns 1. Hardware upgrades
2. Email attachments
3. System updates
4. Software licensing
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Q .66Q .66 Whic h of the fo l lowing s teps  is  us ed to  open a s preads heet in M S  E xcel?Whic h of the fo l lowing s teps  is  us ed to  open a s preads heet in M S  E xcel?
A nsA ns 1. Use the key combination of Alt+Z -> Select Open -> Press Enter

2. Use the key combination of Alt+E -> Select Open -> Press Enter
3. Use the key combination of Alt+F -> Select Open -> Press Enter
4. Use the key combination of Alt+M -> Select Open -> Press Enter

Q .67Q .67 In M S  PowerPoint ,  whic h feature a l lows  a us er  to  run a s l ide s how on one monitorIn M S  PowerPoint ,  whic h feature a l lows  a us er  to  run a s l ide s how on one monitor
whi le ed it ing the pres entat ion on another  monitor?whi le ed it ing the pres entat ion on another  monitor?

A nsA ns 1. Presenter View
2. Normal View
3. Slide Sorter View
4. Review Mode

Q .68Q .68 What is  one of the key  c hal lenges  of e- c ommerce?What is  one of the key  c hal lenges  of e- c ommerce?
A nsA ns 1. Cybersecurity threats

2. Inability to operate 24/7
3. High physical store costs
4. Limited product availability

Q .69Q .69 Whic h of the fo l lowing fields  in an email  is  us ed to  s pec ify  the pr imaryWhic h of the fo l lowing fields  in an email  is  us ed to  s pec ify  the pr imary
rec ipient(s)  of  the email  mes s age?rec ipient(s)  of  the email  mes s age?

A nsA ns 1. To
2. CC
3. BCC
4. Subject

Q .70Q .70
A nsA ns 1. 

2. 
3. 
4. 
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Q .71Q .71 In M S  Word ,  whic h of the fo l lowing s teps  c orrec t ly  des c r ibes  the method toIn M S  Word ,  whic h of the fo l lowing s teps  c orrec t ly  des c r ibes  the method to
c reate a  new doc ument bas ed on a c us tom template that  one has  s aved in ac reate a  new doc ument bas ed on a c us tom template that  one has  s aved in a
s pec ific  fo lder  on the c omputer?s pec ific  fo lder  on the c omputer?

A nsA ns 1. Go to the File tab, select New, click on Personal, browse for the custom template
folder, and open the template.

2. Go to the Home tab, click on New Document, and browse for the custom template.
3. Go to the Insert tab, click on New Document, and select the custom template.
4. Go to the View tab, click on New, and select the custom template.

Q .72Q .72 Whic h of the fo l lowing fo lders  in an email  s y s tem c ontains  the emails  y ou haveWhic h of the fo l lowing fo lders  in an email  s y s tem c ontains  the emails  y ou have
s ent to  others?s ent to  others?

A nsA ns 1. Outbox 
2. Drafts
3. Spam
4. Inbox

Q .73Q .73 C y bers ec ur ity  is  es s entia l  for  bus ines s es  in order  to :C y bers ec ur ity  is  es s entia l  for  bus ines s es  in order  to :
A nsA ns 1. avoid paying taxes

2. improve the internet browsing speed
3. ensure that their computers run faster
4. protect sensitive data from unauthorised access

Q .74Q .74 Whic h of the fo l lowing options  is  us ed to  c hange the s ize of font  in M S  Word?Whic h of the fo l lowing options  is  us ed to  c hange the s ize of font  in M S  Word?
A nsA ns 1. Paragraph

2. Styles
3. Font
4. Clipboard
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Q .75Q .75 M atc h the options  of pr int ing s ett ings  from G roup A  with their  des c r ipt ions  inM atc h the options  of pr int ing s ett ings  from G roup A  with their  des c r ipt ions  in
G roup B.G roup B.

G roup A  G roup A  G roup BG roup B
1 .  Pr int  A l l  Pages  1 .  Pr int  A l l  Pages  i .  Jus t  what y ou s elec tedi .  Jus t  what y ou s elec ted
2 .  Pr int  S elec t ion 2 .  Pr int  S elec t ion i i .  Jus t  this  pagei i .  Jus t  this  page
3.  Pr int  C urrent Page 3.  Pr int  C urrent Page i i i .  The entire doc umenti i i .  The entire doc ument
4 .  C us tom Pr int  4 .  C us tom Pr int  iv.  Ty pe s pec ific  pages ,  s ec t ions  and rangesiv.  Ty pe s pec ific  pages ,  s ec t ions  and ranges

A nsA ns 1. 1-i, 2-ii, 3-iii, 4-iv
2. 1-iii, 2-i, 3-ii, 4-iv
3. 1-ii, 2-iv, 3-i, 4-iii
4. 1-iv, 2-iii, 3-ii, 4-i

Q .76Q .76 How does  a  us er  add a new pr inter  in Windows  1 0 ?How does  a  us er  add a new pr inter  in Windows  1 0 ?
A nsA ns 1. Change the system date and time to enable printer addition

2. Use the 'Add or Remove Programs' feature in Control Panel
3. Open Task Manager > Select 'Add Printer'
4. Go to Settings > Devices > Printers & scanners > Add a printer or scanner

Q .77Q .77
A nsA ns 1. 

2. 
3. 
4. 

Q .78Q .78 Whic h of the fo l lowing is  NO T a ty pe of ins tal lat ion in Windows  O S ?Whic h of the fo l lowing is  NO T a ty pe of ins tal lat ion in Windows  O S ?
A nsA ns 1. Double-location installation

2. Parallel installation
3. Direct installation
4. Single-location installation

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .79Q .79 How many  levels  of  nes t ing are done in the fo l lowing M S  E xcel  formula?How many  levels  of  nes t ing are done in the fo l lowing M S  E xcel  formula?

=IF( AV E RA G E ( F2 : F5) >50 ,S UM (G 2 : G 5) ,0 )=IF( AV E RA G E ( F2 : F5) >50 ,S UM (G 2 : G 5) ,0 )
A nsA ns 1. One

2. Two
3. Four
4. Three

Q .80Q .80 When s ort ing a c o lumn with mixed data ty pes  (e.g . ,  text  and numbers) ,  what wi l lWhen s ort ing a c o lumn with mixed data ty pes  (e.g . ,  text  and numbers) ,  what wi l l
M S  E xcel  do?M S  E xcel  do?

A nsA ns 1. Display an error message
2. Sort text and numbers together in random order
3. Sort text first, then numbers
4. Ignore all text values and only sort numbers

Q .81Q .81 If  4% of x  =  2 64 ,  then x  is  equal  to :I f  4% of x  =  2 64 ,  then x  is  equal  to :
A nsA ns 1. 6700

2. 13300
3. 6600
4. 13200

Q .82Q .82 A  s hopkeeper  l is ts  the pr ice of a  fan at  55% above its  c os t  pr ice and offers  a  3 0 %A  s hopkeeper  l is ts  the pr ice of a  fan at  55% above its  c os t  pr ice and offers  a  3 0 %
dis c ount on its  l is t  pr ice.  I f  he earns  a  profit of ₹1 3 6 ,  then what is  the l is t  pr icedis c ount on its  l is t  pr ice.  I f  he earns  a  profit of ₹1 3 6 ,  then what is  the l is t  pr ice
( in ₹)  of  the fan?( in ₹)  of  the fan?

A nsA ns 1. 2,194

2. 2,365
3. 2,480
4. 2,558

Section : Quantitative Aptitude
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Q .83Q .83 The inc ome of A mit  in 2 0 1 9 was  ₹2 3, 50 0 .  He gets  an inc rement of 1 0 % everyThe inc ome of A mit  in 2 0 1 9 was  ₹2 3, 50 0 .  He gets  an inc rement of 1 0 % every
y ear.  What was  his  inc ome ( in ₹)  in 2 0 2 1 ?y ear.  What was  his  inc ome ( in ₹)  in 2 0 2 1 ?

A nsA ns 1. 23,500
2. 28,200
3. 25,850
4. 28,435

Q .84Q .84 There are two pipes  that  c an fil l  a  tank  together  in 1 2  minutes .  I f  one pipe fil ls  theThere are two pipes  that  c an fil l  a  tank  together  in 1 2  minutes .  I f  one pipe fil ls  the
tank  one and a half  t imes  fas ter  than the other,  how long ( in minutes)  wi l l  i t  taketank  one and a half  t imes  fas ter  than the other,  how long ( in minutes)  wi l l  i t  take
for  the fas ter  pipe to  fil l  the tank  on its  own?for  the fas ter  pipe to  fil l  the tank  on its  own?

A nsA ns 1. 22
2. 20
3. 18
4. 24

Q .85Q .85 5 t imes  the pres ent age of Renu is  1 9  y ears  more than 3  t imes  the pres ent age of5 t imes  the pres ent age of Renu is  1 9  y ears  more than 3  t imes  the pres ent age of
M anav,  and 8  t imes  the pres ent age of M anav is  9  y ears  les s  than 5 t imes  theM anav,  and 8  t imes  the pres ent age of M anav is  9  y ears  les s  than 5 t imes  the
pres ent age of Renu.  The s um of the pres ent ages  ( in y ears)  of  Renu and M anavpres ent age of Renu.  The s um of the pres ent ages  ( in y ears)  of  Renu and M anav
is :is :

A nsA ns 1. 9
2. 7
3. 5
4. 11

Q .86Q .86 Tap A  c an fil l  a  buc ket  1 . 5 t imes  fas ter  in c omparis on to  tap B.  It  takes  1 2  minutesTap A  c an fil l  a  buc ket  1 . 5 t imes  fas ter  in c omparis on to  tap B.  It  takes  1 2  minutes
for  tap A  and B  to  fil l  the buc ket  together.  How muc h t ime wi l l  tap B  a lone takefor  tap A  and B  to  fil l  the buc ket  together.  How muc h t ime wi l l  tap B  a lone take
to fil l  the buc ket?to  fil l  the buc ket?

A nsA ns 1. 18 minutes

2. 22.5 minutes
3. 21 minutes
4. 30 minutes
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Q .87Q .87 E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 70  − 7 ) } ]E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 70  − 7 ) } ]
A nsA ns 1. 1527

2. 1672
3. 1457
4. 1597

Q .88Q .88 A  bus  c overed 65 km in the firs t  hour  and 55 km in the next  hour.  What is  itsA  bus  c overed 65 km in the firs t  hour  and 55 km in the next  hour.  What is  its
average s peed?average s peed?

A nsA ns 1. 60 km/hr
2. 62 km/hr
3. 68.5 km/hr
4. 55 km/hr

Q .89Q .89 In an elec t ion between two c andidates ,  the firs t  c andidate got  60 % of the totalIn an elec t ion between two c andidates ,  the firs t  c andidate got  60 % of the total
val id  votes .  1 0 % of the votes  were inval id .  I f  the total  number of votes  wasval id  votes .  1 0 % of the votes  were inval id .  I f  the total  number of votes  was
1 0 ,0 0 0 ,  then find the number of val id  votes  the s ec ond c andidate got .1 0 ,0 0 0 ,  then find the number of val id  votes  the s ec ond c andidate got .

A nsA ns 1. 3000
2. 3600
3. 3100
4. 4200

Q .90Q .90 E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 8) } ]E valuate:  1 850  − [ 4 50  − { 2 1 0  − ( 90  − 80  − 8) } ]
A nsA ns 1. 1683

2. 1468
3. 1608
4. 1538
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Q .91Q .91 Whic h of the fo l lowing is/are the mos t benefic ial  for  a  c us tomer?Whic h of the fo l lowing is/are the mos t benefic ial  for  a  c us tomer?

S c heme 1 )  Buy  5 get  4  free.S c heme 1 )  Buy  5 get  4  free.
S c heme 2 )  Buy  5 get  7.S c heme 2 )  Buy  5 get  7.
S c heme 3 )  Two s ucces s ive d is c ounts  of 1 0 % and 5%.S c heme 3 )  Two s ucces s ive d is c ounts  of 1 0 % and 5%.

A nsA ns 1. Only scheme 1
2. Both schemes 1 and 2
3. Both schemes 2 and 3
4. Only scheme 2

Q .92Q .92 80 % of the members  at  the A rmy  c lub are men and 2 0 % are women.  I f  the80 % of the members  at  the A rmy  c lub are men and 2 0 % are women.  I f  the
average age of the men is  3 0  y ears  and the average age of the women is  4 0average age of the men is  3 0  y ears  and the average age of the women is  4 0
y ears ,  then what is  the average age ( in y ears)  of  a l l  the members?y ears ,  then what is  the average age ( in y ears)  of  a l l  the members?

A nsA ns 1. 30
2. 34
3. 31
4. 32

Q .93Q .93

A nsA ns 1. 
2. 
3. 
4. 

Q .94Q .94 The marked pr ice of a  c ooker  is  s ame at  four  s hops  I ,  I I ,  I I I  and IV.  S hop I  a l lowsThe marked pr ice of a  c ooker  is  s ame at  four  s hops  I ,  I I ,  I I I  and IV.  S hop I  a l lows
two s ucces s ive d is c ounts  of 4 6% and 62 %, s hop I I  a l lows  s ucces s ive d is c ounts  oftwo s ucces s ive d is c ounts  of 4 6% and 62 %, s hop I I  a l lows  s ucces s ive d is c ounts  of
1 6% and 77%, s hop I I I  a l lows  s ucces s ive d is c ounts  of 74% and 54% and s hop IV1 6% and 77%, s hop I I I  a l lows  s ucces s ive d is c ounts  of 74% and 54% and s hop IV
al lows  s ucces s ive d is c ounts  of 1 2 %, 98% and 86% on the marked pr ice of theal lows  s ucces s ive d is c ounts  of 1 2 %, 98% and 86% on the marked pr ice of the
c ooker.  Whic h s hop is  s el l ing the c ooker  at  the lowes t  pr ice?c ooker.  Whic h s hop is  s el l ing the c ooker  at  the lowes t  pr ice?

A nsA ns 1. II
2. I
3. IV
4. III
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Q .95Q .95 P s el ls  an item to  Q  at  2 0 % profit .  Q  s el ls  the s ame item to  R at  72 % los s .  I f  RP  s el ls  an item to  Q  at  2 0 % profit .  Q  s el ls  the s ame item to  R at  72 % los s .  I f  R
paid  ₹4 ,1 1 6  for  the item, then at  what pr ice ( in ₹)  was  the item purc has ed by  P?paid  ₹4 ,1 1 6  for  the item, then at  what pr ice ( in ₹)  was  the item purc has ed by  P?

A nsA ns 1. 12,248
2. 12,253
3. 12,252
4. 12,250

Q .96Q .96

A nsA ns 1. 2
2. 1.3
3. 3.1
4. 1

Q .97Q .97 Three y ears  ago ,  the age of A  was  three t imes  the age of B.  The rat io  of  theirThree y ears  ago ,  the age of A  was  three t imes  the age of B.  The rat io  of  their
pres ent ages  is  7  :  3.  F ind the s um of their  pres ent ages .pres ent ages  is  7  :  3.  F ind the s um of their  pres ent ages .

A nsA ns 1. 50 years
2. 30 years
3. 20 years
4. 40 years

Q .98Q .98 The average of 6 . 5,  1 0 .6 ,  1 9 .7  and a is  1 4 .  The value of a  is :The average of 6 . 5,  1 0 .6 ,  1 9 .7  and a is  1 4 .  The value of a  is :
A nsA ns 1. 20.2

2. 21.2
3. 19.2
4. 18.2

Q .99Q .99 Two expres s  trains  of lengths  3 2 0  m and 3 80  m s tarted moving from A hmedabadTwo expres s  trains  of lengths  3 2 0  m and 3 80  m s tarted moving from A hmedabad
to Delhi  at  the s ame t ime.  Their  s peeds  are 84  km/ h and 4 2  km/ h,  res pec t ively .  Into  Delhi  at  the s ame t ime.  Their  s peeds  are 84  km/ h and 4 2  km/ h,  res pec t ively .  In
how many  s ec onds  wi l l  the fas ter  train c ros s  the s lower  train?how many  s ec onds  wi l l  the fas ter  train c ros s  the s lower  train?

A nsA ns 1. 60 sec
2. 45 sec

3. 120 sec
4. 50 sec
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Q .1 0 0Q .1 0 0

A nsA ns 1. 

2. 

           
3. 

            
4. 
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